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QUESTION 1
SIMULATION

Project 6 of 7: Bike Tours Overview

You are the owner of a small bicycle tour company summarizing trail rides that have been booked for the next six
months.

¥ BikeTours - Excel able L] = O x
Insert Page Layout Formulas Data Review View Q@ Tell me.. Sign in R_ Share
&D J__‘ i o P | = o P = General i %Condi‘tinnal Formatting = Insert ~ | 2 ~ ’2"!' -
Eg ~ sl $ - % »  [¥FormatasTable~ 2 Delete = - P~
Pa:;te ~ B I U- - | O == s ) 8 8 '—'FCEII Styles = El Format~ | & -
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1 —
2 . i e =1
:l Adventure Works
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5 —
7 |Casual BikerinnTour  July Toby Nixon 4-Day/3-N 11 $600.00 $6,600.00 |
8 |Casual BikerInn Tour  August Sabina Schuetz 4-Day/3-N 2 $600.00 51,200.00
9 |Casual Biker Inn Tour  September Mindy Martin 4-Day/3-N 4 $600.00 $2,400.00 |
10 |Gully Wash Loop July Lee Oliver 1/2 Day 5 $75.00 $375.00
11 |Gully Wash Loop August Katie Jordan 1/2 Day 10 $75.00  $750.00 |
12 |Gully Wash Loop September Kathie Flood 1/2 Day 16 $75.00 $1,200.00
13 |Kokopelli Trail July Julian Isla 4-Day/3-N 15 5450.00 56,750.00
14 |Kokopelli Trail August Judy Lew 4-Day/3-N 12 $450.00 55,400.00
15 |Kokopelli Trail September John Peoples 4-Day/3-N 10 $450.00 $4,500.00 |
16 |Raccoon Rim Trail July Iris Rogers 1Day 20 $110.00 $2,200.00
17 |Raccoon Rim Trail August Holly Dickson 1 Day 8 5110.00  $880.00 |
18 |Raccoon Rim Trail September Gail Erickson 1 Day T $110.00 $770.00
19 |Slickrock Trail July Eric Gruber 1/2 Day a0 $75.00 $3,000.00 |
20 |Slickrock Trail August Debra Core 1/2 Day ] $75.00  $675.00
21 |Slickrock Trail September Chris Ashton 1/2 Day 21 $75.00 $1,575.00 |
22 |White Pine Trail July Bradley Beck 3-Day/2-N 15 $300.00 54,500.00
23 |White Pine Trail August Bonnie Kearney 3-Day/2-N 6 $300.00 $1,800.00 |
24 |White Pine Trail September Arlene Huff 3-Day/2-N 12 $300.00 $3,600.00
_25__ -
Summer Bookings | (&) 1 ' [r

Ready B m - | + 100

Insert page numbering in the center of the footer on the “Summer Bookings” worksheet using the format Page 1 of ?.
Correct Answer: See explanation below.

Explanation:

1. On the “Summer Bookings” worksheet, click Header and Footer from the Text group situation on the

Insert tab.
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2.

Click Click to add footer which would display the Header and Footer tools which gets added to the Design tab.

3.

Specify where the page number should be by selecting the Center section box.

4.

On the Design tab in the Header and Footer Elements group, click Page Number.

5.

The placeholder and[Page] will appear in the selected section, to add the total number of pages type the word of
followed by the space in the Header and Footer Elements group after clicking Number of Pages, then the placeholder
and[Page] of and[Pages] appear.

6.

Click anywhere outside the header or footer area to display the page numbers in Page Layout View.

7.

Once you are done working in the Page Layout View, click Normal in the Workbook Views group situated on the View
tab. OR You can also click Normal on the status bar.

References:

https://support.office.com/en-us/article/Insert-page-numbers-on-
worksheets-27A88FB9-F54E-4AC4-84D7BF957C6CE29C

QUESTION 2
SIMULATION
Project 3 of 7: Tree Inventory Overview

You are updating the inventory worksheet for a local tree farm.
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T Treelnventory - Excel

Insert Page Layout Formulas Data Review View Tell me what you want to do Sign in

General i Cnndi‘tinnal Formatting = E‘“Insert v | 27'

m Calibri ==%- =
By~ e $-9% 9 [.# Format as Table~ E" Delete ~ E - 2~
Paste o B I U- === e&=3= T | «g od [57 Cell Styles~ Format~ & -
Clipboard Font 1M Alignment (Pt Number & Styles Cells Editing ~
G41 - Jlies 5 b
H [<]
9 |Tree Description ‘Seedling ‘Bare Root ‘5 Gallon 10 Gallen Total |
10 |Bigleaf Maple | 4400 443 55 5 4303
11 |Black Cottonwood _ 335 230 a4 8 617
12 | Blue Spruce | 4500 543 55 4 5102
13 |California Black Oak | 750 330 30 7| 1117
14 |California Red Fir 2000 355 25 2 2382
15 Canyon Live Oak falule} 150 ]5 5: 270
16 |Coast Redwood _ 2500 249 10 2 2752
17 | Douglas Fir _ 2700 300 33 7| 3040
18 |Englemann Spruce | 550 100 25 5| 680
18 |Giant Sequoia | 450 50 30 4 334
20 |Grand Fir _ 2500 644 81 9 3234
21 |Incense Cedar _ 3000 434 a5 3 3482
22 | Jeﬁ(ey Pine | 350 253 13 5 827
23 |Juniper _ 545 330 20 6 901
24 |Knobcone Pine [ 450 210 15 7 682
25 |Lodgepole Pine | 600 360 20 6 986
26 |Noble Fir _ 1200 101 18 1 1330
27 |Oregon White Oak | 1100 240 20 15 1375
28 |Pacific Madrone | 1000 165 60 6 1231
29 |Pacific Yew _ 950 95 3z 3 1080
30 | P_onde_msa Pine | 400 107 35| 4 546
31 |Port Orford Cedar | 2200 2200 22 4 24458
32 |Red Alder [ 1600 160 34 6 1800
33 |Silver Fir _ 250 120 27| 8 405
34 |Sitka Spruce [ 250 120 27 8 405
35 |Sugar Pine | 250 101 45 2 398,
36 |Western Hemlock | 550 107 25 7| 689
37 |Western Red Cedar [ 450 120 30 5 605 -
38 |White Fir 2500 120 B1 a4 2705
- | | | | I i
4 Tree Inventory ) i 4] | ]
Ready ) - B B -——F——+ 100%

Configure the worksheet so that row 9 and the WordArt remain visible as you scroll vertically.
Correct Answer: See explanation below.

Explanation:

1.

Select the cells below the rows and to the right of the columns you want to keep visible, which in this case is row 10
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and column H.
2.
Click Freeze Panes from the Freeze Panes group in the View tab.

References: https://support.office.com/en-ie/article/Freeze-panes-to-lock-rows-and-columns-
dab2ffc9-020d-4026-812167dd25f2508f

QUESTION 3
SIMULATION

Project 2 of 7: Donor List
Overview

You are an executive assistant for a non-profit organization named Bellows College. You are updating a workbook
containing lists of donors.

s DonorList xlsx - Excel

Insert Page Layout Formulas Data Review View Q Tell me what you want to do. Sign in P_'_ Share
Y = X i o v - Ay
D % Calibri -k & |==B - = General %CundltlunalFurmattmg %“Inser‘( E 7
. g - $ - 9% v [ZFFormatas Table~ &7 Delete - - P
aste . e Py === == - - st
- » Al ” - A ====xH o 28 77 Cell Styles - B Format> & -
Clipboard & Font ] Alignment . Number & Styles Cells Editing -~
Al ¥ 5 v
A B | ¢ | D | E | F | & | H | | 4 | kK | Lt | M [
i ]
. Bellows College Donors - $5,000 Level
3 |Compiled by: John Arthur
4 =
5 -
2
? -
8 -
§5,000 Donors ® [« I D
Reaoy i B i —+ 100%

Arrange the worksheets so that “$5,000 Donors” is first.

Correct Answer: See explanation below.

Explanation:

1.

Click Sort Sheets from the Worksheet group in the Kutools Plus tab.
2.

Click the Alpha sort button OR the Alpha Numeric Sort button in the Sort Sheets dialog box, the results can be
previewed in the New sheets tab order list box.
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3.

Use the Move up or Move down button to manually change the order of the sheets so that the “$5,000 Donors”
worksheet is first in the New sheet tabs order list.

4,
Click OK once satisfied with the results.
References:

https://www.extendoffice.com/product/kutools-for-excel/sort-worksheets-in-one-workbook-in-alphabeticalorder.html

QUESTION 4
SIMULATION

Project 4 of 7: Car Inventory
Overview

You manage the office of a used car business. You have been asked to prepare the inventory list for a big annual sale.
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Carlnventory - Excel (m| x
Insert Page Layout Formulas Data Review View m want to do... Sign in P_‘,_ Share
LT 4 Calibri I A == - % General - Ccmdi‘ticmal Formatting + E"Insert v Z - g'l'v
p D Eg - = e $-% > EFurrnnL as Table - E" Delete - E =i
a:vte ‘. B I U~ [ A | Ee=Ee T e m I8 Cell Styles + EiFormat~ | &+
Clipboard = Font P Alignment . Mumber m Styles Cells Editing ~
AB 1.2 I v
1 A 1 | [«
+§ [
2 Z
3 i
g |
h_
6_
aFig
) — - |
9 |Make Model Body Year Color Mileage Price Inspected Discounted Price |
10 |Mitsubishi 3000 GT Sport 1985 White 198000 54.000.00 Yes
11 |Honda Civic 4-door 2000 Red 150000 53,000.00 No |
12 |Ford Ranger Pickup 1986 Blue 208000 53.200.00 Yes I
13 |Dodge Intrepid Coupe 2002 | Silver 148,000 53,000.00 Yes
14 |Cadillac Seville 4-door 2002 White 141,000 54100.00 Yes
15 |Ford Ranger Pickup 1995 Black 135,000 54700.00 Yes
16 Ford Mustang ESport 1999 Red 188,000 55500.00 Yes l
17 |Chevrolet Camaro Sport 2004 White 122,000 57,000.00 |Yes :
18 |Chevrolet Silverado Truck 2001 Black 178,000 $5,200.00 Yes |
19 |Toyota Tacoma Pickup 2006 White ‘08,000 59,300.00 No
20 |Ford Taurus Sedan 2008 Gold 102,000 59.800.00 No
21 |Mazda Miata Sport 2010 Blue 77,000 58500.00 No
22 |Mercedes 5005L Converible 2003 Gold 185,000 58.000.00 No |
23 |leep Wrangler Converible 2005 Black 122 000 58,200.00 No |
24 |Chevrolet Impala Sedan 2000 Maroon 162,000 54100.00 Yes
25 |Mitsubishi Diamante 4-door 2008 Gold 92,000 HHEE Yes :
26 |Ford Focus Coupe 2012 Blue 58,000 57.900.00 Yes |
27 |Mazda RX-7 Spart 1885 Silver 210,000 53.100.00 Yes l
28 |Harley Davidson  Sportster Motorcycle 2009 Black B2 000 5750000 No |
29 |Honda Gold Wing Motorgicle 2010 Red 76,000 510,100.00 No |
30 |Toyota Tacoma Pickup 2008 Black 78,000 S No |
31 |Ford Ranger Pickup 19495 Black 135,000 54700.00 No
32 |Ford Mustang Sport 2000 White 171,000 57.500.00 No |
33 |Chevrolet Camaro Sport 2005 White 115,000 $8,000.00 No
34 |leep Wrangler Convertible 2006 White 112 000 HiEagaad Yes '
35 |Chevrolet Impala Sedan 2007 Maroon 112,000 5610000 Yes '
36 |Mitsubishi Diamante 4-door 2009 Blue 63,000 HahkER Yes |
37 |Honda Civic 4-daoor 2000 Blue 145,000 53,200.00 Yes |
38 |Ford Ranger Pickup 1985 White 188,000 53.700.00 Yes |
39 |Dodge Intrepid Coupe | 2005 | 5ilver 137,000 53800.00 Yes -
40 |Chevrolet Silverado Truck 2004 White 158,000 57,200.00 Yes
41| -
Car Inventory | (&) 1 — bl
Ready i - I+ + 85%

Apply the Rose, Table Style Light 17 (Table Style Light 17) to the “Inventory” table.
Correct Answer: See explanation below.

Explanation:

1.

On the “Inventory” table, click on any cell.

2.
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Click on Format as Table from the Home tab.

3.

Select the Rose, Table Style Light 17 as desired.
References:

https://support.office.com/en-us/article/Format-an-Excel-table-6789619F-C889-495C-99C22F971C0E2370

QUESTION 5
SIMULATION
Project 5 of 7: City Sports Overview

The city events manager wants to analyze the enrollment changes over the past five years for various adult and youth
sports programs. You have been tasked to prepare tables for the analysis.
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d CitySports - Excel = - | x
Insert Page Layout Farmulas Data Review View YOu v Sign in }Z_ Share
o 1 = - iti ing~ - - Ay,
D o% Calibri T s = = - General ﬁ% Conditional Farmatting iﬁ:ﬂ Insert z zr
: Ba - 5+ 9% 2 Q Format as Table &7 Delete ~ m * P
aste - - - e = = = - 1
gl e L 2-Ar === =7 | %8 48 7 Cell Styles - B Format - & -
Clipboard & Font T Ni_gnment (P Number & Styles Cells Editing ~
H26 i Fe i
g i | 3 | c | B | £ | E | c H |[]
1 T '
;.1_ |
3_
4 e
- orts Program
6 | ; | - o N SN N
- .
o Adult Enrollment |
9: Sport Year1 Year2 Year 3 Year 4 Year 5 Total Growth Trend |
10 |5KRun 35 45 64 Vil 105 325
11 |Basketball _ 8 100 100 110 120 510
12 |Bowling 16 24 32 2 24 124
13 [cycling _ 10 2 a3, 33 59 168
14 | Flag Football 120 160 160 200 200 240
15 |Lacrosse _ 8 120 120 120 120 560 _
16 |Soccer 160 160 160 160 160 800 _ |
17 [Softball _ 150 160 160 170 180 820 !
18 |Swimming 23 30 35 40 a3 171 _ |
19 Tennis _ a a0 50 50 ) 240 ] |
20 | |
218
22_ -
Adult Program | Youth Program | ()] S| I Dl
Ready :i:f mo-— €I 4 100%
s CitySports - Excel
Insert Page Layout Farmulas Data Review View ! =wh . Sign in }-3_ Share
L i T - iti ing T - + Ay
D 3{, [ Catibri T sl gl == = General %Condltlonal Farmatting iE“’Insert E ead
0 Bz~ = $ - % »  [ZFFormatas Table~ ErDelete -~ [B- P~
e - - - -l === i
e g | BB e Rl e W £ (57 Cell Styles Format- & -
Clipboard & Font (7] Nig_nment M Mumber & Styles Cells Editing -~
H27 el 5 v
4 A | B | c | D E | F G H | =]
i)
2
: °
4
5 "
7 D :
¥
5 Youth Enrollment
9: Sport Yearl Year2 Year3 Yeard Years Total
10 | 5K Run 14 25 24 57 a9 209 ‘
11| Basketball 100 120 120 130 150 620
12| Bowling 12 24 24 36 36 132 ‘
13| Cycling 5 10 15 15 5209 5254
14 | Flag Football 120 160 180 200 240 S00 ‘
15| Lacrosse 40 a0 100 120 140 480
16 | soccer 200 220 220 240 300 1180 ‘
17 | Softball 200 200 200 200 200 1000
18| Swimming 40 50 50 60 60 260 |
19 | Tennis 45 30 50 70 30 275
2|
21|
22 | -
Adult Program | Youth Program (€] [« | (]
Ready H H -— 5 —+ 100%
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Add the Alternative Text Title “Adult Enroliment” to the “Adult_Program” table.
Correct Answer: See explanation below.

Explanation:

1.

Right-click the text title “Adult_Program” and click Format Object then click Alt Text.
2.

Type “Adult Enroliment” in the Title box as desired.

3.

Click OK.

References:

https://support.office.com/en-us/article/add-alternative-text-to-a-shape-picture-chart-smartart-graphic-orother-
object-44989b2a-903c-4d9a-b742-6a75b451c669#bkmk_02016_ 2013
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